Introduction to Word Processing

Introduction

Friends, you learnt earlier that computers have been used to handle a variety of activities in diverse
fields for the last two decades. One of the most common uses of computer is in handling office
activities. It is observed that word processing, data processing, communication and presentation are
the most common activities happening in the offices. Computers are used to handle these activities
effectively. We know that different software is available in the market to perform such activities
using computers. Since the start of computer usage, proprietary software is used, but in last few
years, use of open source software has substantially increased due to obvious advantages. In
previous chapters you have studied about proprietary and open source software. Since long back,
software called Microsoft Office (MS-Office) is used to handle the office activities like word
processing, presentation, spreadsheet and others. Similar software is available from open source
community; some of these are Star Office, Libre Office and Open Office. In this chapter we
shall learn about how word processing is done using software called *Writer’ which is a component

of open office.

Word Processing and Word Processor

We are familiar with the word ‘Document’. A document identifies contents written on a paper. In
our day-to-day life we use documents for several purposes. The purpose of writing on papers may
be to convey your thought to others, to preserve the content for longer period or it may be used
as evidence. These documents can be letters, reports, thesis, manuscripts, legal documents, books
etc. Suppose, you want to prepare a document but your handwriting is so bad that even a pharmacist
couldn’t read it or you are the kind of person who has to write, rewrite, and write again. Then

what you need is word processing software.

The activity of word processing is the creation of documents using software (Collection of
Programs) called word processor. The creation of documents means not only typing but also refers
to composition, editing, viewing, formatting, storing, retrieving and printing. Thus a word processor
is a computer application used for the production of any sort of printable material. In late 1960°s
the term word processing was invented by IBM. In the late 1970’s Microsoft WordStar was
the most widely used word processing software. Many other word processing applications also
exist, including WordPerfect and open source applications OpenOffice.org Writer, LibreOffice
Writer, AbiWord, KWord, etc. Web-based word processors, such as Office Web Apps or Google

Docs, are relatively new software facilities.
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Figure 9.1 : A Typical Type Writer
Need of Word Processing

In 18" century a type writer as shown in figure 9.1 was invented to impress characters on paper.
It is a mechanical or electromechanical device with keys that, when pressed, cause characters to
be printed on a medium, usually paper. As days passed several limitations were noticed in using
type writer :

(1) When any typing error was noticed then to correct them the whole sheet was required
to be typed again.

(2) When we needed more copies, every time the same content needs to be typed again
and again.

(3) If one wants to reproduce the same document again with minor changes, the whole
document was required to be typed again. For example, if we want to send same
letter to two or more persons with different addresses, we had to type the letter
multipletimes.

(4) Sometimes it may not be possible to have all the required characters or symbols on
the type writer we are using, and as a result we have to either type a similar character
or symbol or sometimes we have to leave that space and have to write manually.

(5) In case, if a document is to be produced in a particular format, either it may consume
lots of time or it may not be possible to type the document in desired format using
a type writer.

To solve the above mentioned problems with a type writer, in the year 1974 ‘Xerox’ company
introduced a new product called “electronic type writer”. Changes in the content, once typed, are
possible with this kind of type writer. Multiple copies can also be taken out even with minor changes.
But the only problem with electronic type writer is that it has a very small sized screen and therefore
it was possible to view only one or two or very few lines.

In late 1970s the limitations of electronic type writer were replaced by computers. Since then
software are used for word processing. When we use word processor to create a document, the
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contents of the document is displayed on the computer screen. On the screen we can navigate from
one place to another and can make changes if required. After confirming that the content is error
free, we can print it.

Early word processors used tag-based markup for document formatting. When a specific portion
of the content needs some special effect, a particular tag is put on both the sides of the text. For
example, if some portion of the content is required to be bold, a <bold> tag is put on both the
sides of the portion that we want to have bold effects. From last two decades most modern word
processors take advantage of a graphical user interface providing some form of what-you-see-is-
what-you-get (WYSIWYG) editing. This means, the special effects on text are also visible on the
screen.

Features of Word Processor

Word processing does not only provide basic ability to enter and modify the text but also
provides efficient text manipulation functions that can be used for documentation. Modern word
processors provide abundant attractive features. Some of the features provided by popular word
processors are as listed :

e Move a selected text from one place to another place within the document.
e  Copy a selected text for any number of times at any other places within the document.

e Open more than one document at a time and move or copy a selected text from one
document to any other document.

¢  Change the font, font size and even font style of the selected portion of the document.

e Format paragraphs with word wrap, align the paragraph as left aligned, center aligned,
right aligned or justified.

e  Find a particular word within the document and replace the found word by other word.
¢ Check spelling and grammar.

e  Create table, modify the size of the selected rows, columns or cells.

e  Split a single cell into more than one or merge more than one selected cells into one.
e  Combine one or more documents.

e Insert pictures or graphs within the document.

e Print the selected text or selected pages of the document.

Over and above the features listed, word processors also provide several advanced
features like :

¢  Batch mailings, using a letter template and an address database (also called mail merging)
e Line and page numbering.

¢  Footnote numbering.

e  Character count, word count, sentence count, line count, paragraph count, page count.
e Word, sentence and paragraph length.

e  Editing time.
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In short a word processor is powerful software that consists of one or more programs that can
produce any arbitrary combination of images, graphics and text.

General Applications of a Word Processor

Word processors have a variety of uses and applications within the business world, home, and
education i.e in schools and colleges. Word processors are widely used in most of the offices for
preparing letters, letterheads, reports, memorandums, balance sheet report and many other
different types of documents like legal copies and reference documents. Businesses tend to
have their own format and style for these documents. Apart from business, word processors
are useful at home. Many homes have word processors on their computers; students use it for
preparing project reports and assignments. It is also used for letter writing, resume creation
and card creation. Authors use word processing software for preparing articles and manuscripts
of books. Researchers use word processors for preparing thesis and teachers use it for preparing
question papers or study materials and notes. In short word processing is observed to be the most
popular application of a computer, since preparation of varieties of documents is a common need
for many people.

Office Suite

Friends, before we start the word processor — Writer, let us have a look at the Open Office
suite.

Office suite is a collection of programs, which are useful for word processing, database
management, presentation, spreadsheet preparation and many more such applications. There are
several open source office suites like GNOME Office, NeoOffice, SoftMaker Office, Star office
etc. In this book we shall learn about the components of Open Office 3.2. This suite is available
in many languages and runs on many platforms. The application components of OpenOffice are
Writer for word processing, Calc for spreadsheet preparation, Impress for presentation, Base for
database management, Draw for drawing and others. OpenOffice.Org. is widely used Office suite.
Files created in the components of this Office suite, can be read and edited in other office suites
like MS-Office and vice versa. Hence we can easily share our documents with our friends who
may use different office suites.

Writer - The Word Processor

As mentioned earlier Writer is part of the OpenOffice.org(OOo)
— Open Office suite. It is a kind of word processor which

provides almost all the features of word processing. In the =
previous chapter, you have learnt about an operating system. ﬂpen(ﬂﬂce‘grg'
We assume that you already have Ubuntu 10.04 LTS operating Word Processor
system installed on your computers. You can open Writer in

i i Figure 9.2 : Writer Icon
different ways. One of the most common ways to start Writer
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is to double click on Openoffice.org Word Processor Icon, if it is exist on the desktop (See figure
9.2). This action will open a window as shown in figure 9.3.

Alternatively you can choose Applications — Office — OpenOffice.org Word Processor
(See figure 9.4).
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Figure 9.3 : Writer Window

As shown in the figure 9.3, the top most line in the main window is Title Bar, where the current
file name is displayed and when the file is newly created, Untitled 1, will appear as file name. Second
line that is just below the Title Bar is the Menu Bar, from where we can access different menus
like File, Edit, View, Insert, Format, Table, Tools, Windows and Help. If you have worked in
MS-Word, you can notice that the menu bar contains almost similar options. If any of the menu
items is selected, a submenu drop down becomes visible, below the selected item; it allows us to
select different commands.

Figure 9.4 : Alternate Method to Open Writer
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File menu contains the options that apply to the entire document such as Open, Save as,
Print and many more. Edit menu includes the commands for editing the document such as cut,
copy, paste, undo, redo, find and replace. Commands that permit to manage the display of the
document such as print layout, web layout, full screen, ruler are included in View menu.
Commands for inserting any objects in the document like pictures, sounds, graphs, headers,
footers are the part of Insert menu. Options required for formatting the layout of the current
document are available in Format menu. Bullets and numbering, styles and formatting, change case
are some of the options available in Format menu. Table creation, modification in it, adjustment
of rows and columns, everything related to table is done through Table menu. Options like
Checking of spelling and grammar, change of language, line numbering, and word count are
available in Tools menu. Window menu is normally used when more than one document is
opened. Switching from one document to other and to view all the documents on screen at the
same time is possible through this menu. When you want any help regarding Writer such as to
know about any option of the menu you may select the last menu option Help.

Figure 9.5 shows the options available under the Tools menu. The toolbar, just under the Menu
bar is known as Standard toolbar. This toolbar contains short=cuts in the form of symbols called
icons, to create a file, open existing file, save file, print file and allows us to perform various other
operations on a document. This toolbar is same across all the applications (Writer, Calc, Draw,
and Impress) of the OpenOffice.org. For example when you click on File menu, a drop down list
will appear for various options. If you select New option then a sub menu will appear to its right
as shown in figure 9.6.
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Figure 9.5 : Tools Menu
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Figure 9.6 : Sub Options of New

The sub menu shown in figure 9.6 contains options for opening the file in other components of
the open office. Here if you select text document then the window for creating a writer document
will open and if you select spreadsheet then the window of Calc Component will be loaded and
displayed on the screen.

The other toolbar is the Formatting toolbar. It shows the short cuts to various options for formatting
the selected portion of the document. This is context-sensitive that is the tools are relevant to cursor
position or selection. When the cursor is on picture, the Formatting bar gives tools for formatting
picture, if cursor is in a table, tools for formatting table is provided and when the cursor is in text,
the tools are for formatting text.

There are other toolbars, which will be discussed as and when the relevant topic will be
discussed. The other toolbars can be displayed and hide as and when we wish. Select View
Menu and then Toolbar option as shown in figure 9.7, you can see different toolbars. From the
list, click on the name of a toolbar, you want to display. An active toolbar shows a check mark
v beside its name. To hide any of the active toolbar, click on the name of the toolbar you want
to hide.
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Figure 9.7 : Choosing Toolbar from View Menu

Moving Toolbars

To move a toolbar, place the mouse pointer over the toolbar handle as seen in figure 9.8,
hold down the left mouse button, drag the toolbar to the new location, and then release the

mouse button.
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Figure 9.8 : Moving Toolbar

Creating a New Text Document

You can create a new document in many different ways in OpenOffice. One way to create
a new document is to choose File - New — Text Document (see figure 9.6). Alternatively
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we can press CTRL + N on the key board or clicking on New ?_!_, " icon on the standard

toolbar.

Creating a New Text Document From Template

You can use templates to create new documents in Writer. A template is a set of predefined styles
and formatting. Templates can work as the basic unit of a set of documents. You can create new
documents based on them by using File — New — Templates and Documents. This opens a dialog

box as shown in figure 9.9, where you can choose the template you want to use for your

document. Select the desired name and click on Open.
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Figure 9.9 : Creating a New Text Document from Template

Opening an Existing Document

A document can be opened from any component of the OpenOffice. Simply select File — Open
or Double click on Open 1-‘ icon shown in figure 9.10 on Standard Toolbar or press

CTRL + O on the key board. This will take you to the open dialog box. Select the file you want
and then click on open button. If you want to reduce the list of files on the screen, you can
select the file type in the open dialog box. Writer will open only those types of file which you
select as file type, if a document is already opened the second document opens in a new

window.
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Figure 9.10 : Opening a Document

Saving a Document
We can save the documents created by performing any one of the actions mentioned herewith :
e Choose File Save
e Press CTRL + S
e  Choose the save button on the standard toolbar.
If the said actions are performed for the first time, then a Save dialog box as shown in figure 9.11
will appear. Enter the file name and click Save. Here you can save the file with the same name
or other name. Directly click on Save. This will overwrite the last saved file. If you give different
name in File Name option then the file will be stored with the other name you have given. The

file is saved with the latest changes you have made in the file and at the same time last saved
file will remain with the original name. The extension of the file name will be .odt.

Name: Untitied 1

Save in folder:

+ Browse for other folders

+ File type

Save with password

aCBNEs gy SR
Figure 9.11 : Save Dialog Box

Saving a Document Automatically

To make sure that the data we are writing in the document doesn’t get lost in case of eventualities
like power failure, Open office provides a feature of auto save. Setting this option forces the Writer
software to save your document automatically at regular intervals. Automatic saving, like manual
saving, overwrites the last saved file. To set up automatic file saving:
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e Select Tools — Options — Load — Save — General.

e Click on Save Auto Recovery information and set the time interval.

This will allow us to set the time interval. The default time interval is 15 minutes. You can change

the time value as per your requirement.

Saving as a Microsoft Word Document

It may happen that you have to share your documents with others and the person you are
sharing with, not necessarily use the OpenOffice Writer. Sharing with other is only possible if
other person install OpenOffice on his computer or you should be able to convert your
*.odt file in MS-Word form before sharing it. Fortunately Writer provides the facilities that
the document created in Writer can be saved in MS-Word form. To save document in

MS-Word form

e C(Click File — Save As. The Save dialog box will appear as shown in figure 9.12.
On the Save dialog box, in the File type drop-down menu, select the type of Word

format you need.

e Click Save.
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Figure 9.12 : Dialog Box to Save File in Other Formats

You should note here that before you save the document in MS-Word format, you have to save
your document in the file format used by OpcnOfficc Writer (i.e..odt), otherwise, any changes you
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made since the last time you saved will only appear in the Microsoft Word version of the
document. From this point on wards, all changes you make to the document will occur only in
the MS-Word document. If you want to work with the .odt version of your document, you have
to open it again.

Note :

To have Writer save documents by default in the Microsoft Word file format, Go to
Tools — Options — Load — Save — General. In the section named Default file format,
under Document type, select Text document, then under Always save as, select your desired
file format.

Saving a File With Password

Writer provides document protection that is you can save your file with password. This
document protection is compatible with Microsoft Word file protection. To protect the file with
password perform the steps mentioned:

e Use File — Save As when saving the document. When you are saving a new document
for the first time File — Save option can also be used.

¢  On the Save dialog box, select the Save with password option, and then click Save.
(See figure 9.13)
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Figure 9.13 : Save File With Password

Doing so, an Enter Password dialog box will appear as shown in figure 9.14. If you type the
password in Enter Password text box and then by re-entering the same password again in Reenter
password text box, your file will now be password protected.
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£ Enter Password

Enter password

Reenter password

WARNING: If you lose or forget the password, it
cannot be recovered. It is advisable to keep
passwords in a safe place. Passwords are case-se...
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Figure 9.14 : Enter Password Dialog Box

Document View

Writer provides three different ways to view a document. They are Print Layout, Web Layout and
Full Screen. Each of them is discussed in brief herewith.

Print Layout View
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Figure 9.15 : Print Layout View

The default view option in Writer is the Print Layout view. It will show you the document in the
similar manner as it will be printed (see figure 9.15). Within the Print Layout, the document can
be viewed in single page, side-by-side pages and book style.

To switch from one sub view to another sub-view, respective icon shown on Status Bar, are selected.
Document can be edited in any of these three layouts. Within any layout view magnification can

Introduction to Word Processing 145



also be changed using Zoom slider, shown on the Status Bar shown in figure 9.17. Magnification
can be reduced or amplified by clicking on the — and + signs or by dragging the Zoom slider.
Alternatively right click on the zoom level percentage and then choose the desired value.
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Figure 9.16 : Sub View of Print Layout
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Figure 9.17 : Zoom Slider

Web Layout View

In Web Layout View, no margin, no bold or italic effect or no justification (unlike Print Layout
View) is visible. Figure 9.18 shows a document opened in web layout view. The options of the

Zoom & View Layout Dialog Box here are disabled. But we can use Zoom slider in Web Layout
View.
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Figure 9.18 : Web Layout View
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Full Screen View

In Full Screen view, Title Bar, Menu Bar and status Bar are not visible. The content and the full
screen icon is visible. Rulers are also visible if it is enabled (see figure 9.19). Esc key is pressed
or Full Screen Icon is clicked to exit Full Screen view. Another way to come out from the Full
Screen View is to press CTRL + SHIFT + J.
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Figure 9.19 : Full Screen View

You can also choose View — Zoom from the menu bar to display the Zoom & View Layout dialog

box (see figure 9.20), where you can set the same options as on the Status bar.
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Figure 9.20 : Zoom and View Layout Dialog Box
Closing a Document and Closing OO0 Window

To close a document, select File — Close or Click the Close icon on the left top of the document
window (see figure 9.21) on the document window. By doing so, the document and the Writer
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will be closed, if only one document is opened. If more than
one window is open, then current window will be closed and
the other OO0 windows will remain open.

If the document has not been saved since the last change, a  Figure 9.21 : Close Button
message box is displayed. You will have three options. Save,

Discard and Cancel. If you choose Save; The document is saved and then closed. In case
when Discard is chosen all modifications since the last save are lost and the document is closed.
If Cancel is chosen then nothing happens, and you return to the document. Writer can also be closed
by selecting File — Exit.

Getting Writer Help

Writer provides several forms of help. By pressing F1 a full Help can be attained or selecting
Help — OpenOffice.org Help from the menu bar.

Summary

In this chapter we have learnt about word processor software, characteristics of word
processing software. We also saw the working of open source word processor called
Writer and how to create a document using it. We learnt how to save and protect your document
with password.

EXERCISE

What do you understand by Word Processing ?

Which are the components of Office suite ?

Write at least one advantage and one disadvantage of Electronic Type Writer.

Why word processing is required ?

Write all the menu options of Writer.

Write the steps to move a selected block in the beginning of the document.

Can you save a Writer Document as a Microsoft Word Document ? If yes, How ?

Write steps to save a file with password.

A I A O L

What will you do to save your file automatically after every 30 seconds ? Write all the
steps clearly.

.
=

Which are the different views to display a document ?

(=
-
.

Choose the most appropriate option from those given below :
(1) Which of following is not the component of the Office Suite ?
(a) Writer (b) Impress
(c¢) Internet Explorer (d) Base
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“)

(6)

()

(C)

)

The most widely used word processing software in late 1970’s is :

(a) Word Perfect (b) Word

(¢) Word Star (d) Writer

We can change the mistakes noticed in which of the following ?

(a) Electronic type writer (b) Word processor software

(¢) Simple type writer (d) Both (a) and (b)

To insert Header and Footer we have to go to which of the following menu ?
(a) File Menu (b) Insert Menu

(¢) View Menu (d) Edit Menu

To hide / view ruler we have to go to which of the following menu ?

(a) Tools Menu (b) Insert Menu

(¢) View Menu (d) Edit Menu

To check the grammar we have to go to which of the following menu ?

(a) Tools Menu (b) Insert Menu

(¢) View Menu (d) Language Menu

To replace a word Bombay by Mumbai, we have to go to which of the following
menu ?

(a) Tools Menu (b) Insert Menu

(c) View Menu (d) Edit Menu

To close an opened document, we have to go to which of the following menu ?
(a) File Menu (b) Insert Menu

(c) View Menu (d) Edit Menu

Which of the following is the default extension of the writer file ?

(a) .obt (b) .doc

() .odt (d) .docx

State whether the statements given below are True or False :

e A L

To open word processor ‘Window” menu option is selected.

Current file name is shown in Status Bar.

Open icon for opening a file is part of Standard Tool Bar.

Format Menu contains the options that apply to whole document.

It is possible to open a MS-Word file in Open office — Writer.

We cannot open Open Office — Writer file in MS-Word.

A Tool Bar can also be moved like a selected block of a document.

Templates are pre-defined and exist in the office suite, we cannot create our own.
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9. If we close a document, Writer itself will be closed when only one document is
opened.

10. To open a document from a pen drive, it is required to be copied on the desk top
first.

PRACTICAL EXERCISE

Perform the following exercise on your computer and write all the steps :

1.  Open Writer with the help of icon and Exit. Again open Writer from the Applications options
available on the desktop.

2.  Draw all the icons of Standard Toolbar and write its use in your practical note book.

3.  Draw all the icons of Formatting Toolbar and write its use in your practical note book.

4.  Create a new text document (using Menu bar) showing your name, address and the name
of your school. Save this file with name mydocumentl at the desktop location.

5. Open the document mydocumentl, modify it by adding your division and name of your class
teacher. Save this file as mydocument2 at any other location.

6.  Open both the documents and switch from one to other. Close one of them and save other
as mydocument3 with password.

7.  Open the document mydocument3 and zoom it for 50%, 75%, 130% and 200%.

4
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